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Installation

● Microsoft Windows

Run the installer and follow the instructions.

● Apple macOS

Run the installer and follow the instructions.

● Linux

Run install.sh with Terminal or

Place discoDSP folder at /home/username/Documents/
Place Discovery.so at your VST folder, usually /home/username/.vst/
Place Discovery.vst3 at your VST3 folder, usually /home/username/.vst3/

The demo version cannot store the current synth state, save, or use automation 
functions.
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Description
Discovery is a virtual analog synthesizer emulation with multi-layering, parameter 
morphing, high-quality sound, and a user-friendly interface.

Features
Discovery boasts the following powerful feature set:

● 128 Patch Memories per bank.
● Parameter Morphing.
● 2x oversampling.
● Bank browser (by clicking arrows in display led and bank name).
● More than 3.500 presets in 40 banks (including a percussion set).
● Nord Lead 2 and 2X SysEx patch import.
● 4 Layers per Patch, each with:

○ 2 Oscillators (Sine, Saw, Tri, PWM, Square, Noise) with Ring modulation, sync 
and Frequency Modulation..

○ Resonant Filters (LowPass, HighPass, BandPass, BandReject, Formant, 8 taps 
phaser).

○ ADSR for Amp & Filter.
○ 2 LFOs.
○ AD Mod Envelope.
○ Arpeggiator.
○ Built-in Chorus, Phaser, Panning Delay and Gate effects.
○ Symmetric, Asymmetric and Asymmetric 2 Distortions.
○ Limiter.
○ Portamento.
○ Poly/Mono/Legato modes.

● MIDI CC control.
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Basic Concepts

Quick program select
Click program LED to see a list of available patches.

Bank browser

All banks can be browsed by clicking the arrows in the status LCD or clicking the bank 
name to display a drop-down menu. Banks are located at Discovery folder at 
~/Documents/discoDSP/. Banks can be added by placing .fxb files there.

Morphing state knob editing
In normal mode, holding CTRL while moving the knob will modify morph sensibility. The 
behavior in the knobs will be backwards when Morph mode is on. Use Ctrl+Alt+Left click 
to reset.

Fine tune knob editing
To have more detailed parameter adjustments, hold your Shift key while moving the 
knob to edit both states. Shift and Ctrl keys can be used at once too.
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LFO Sync to host tempo

Discovery’s LFO1, LFO2 / Arpeggiator, Delay and Panning LFO can be synced your host 
tempo. To enable it, just click the led located next to the LFO knob or Delay amount.

Edit operations
Several editing operations are available through the MENU button on the Discovery GUI.
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Layers
Discovery can hold 128 patches at any one time. Each patch may contain up to 4 layers.

Combining layers can be used to create complex sounds that simple subtractive 
synthesis cannot achieve.

Discovery supports up to 32 polyphonic voices. If all 4 layers are enabled, a single note 
will count as 4 individual voices, reducing the actual polyphony to 8 in these instances.  
Fortunately, these are 8 extremely powerful sounds.

To select a layer, simply left-click the A, B, C, D buttons below the Program and Voice 
number LEDs.

A is the default layer. When a layer is active the BUTTON directly above it turns 
highlighted.  Select any layer (B, C, D) to activate it.

When a program includes 2 or more layers, the selected layer button turns highlighted 
and other active layers turn YELLOW. If you wish to disable a layer simply click it twice.

Discovery allows you to copy and paste between layers or programs by using EDIT menu.

The following documentation applies to a single layer unless otherwise noted.  This 
means feature (LFO's, Envelopes, Oscillators) are potentially quadrupled for each 
Discovery patch.
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Parameter Morphing
Each layer contains two internal states: morph source and morph sensibility.  Each state 
contains a unique set of all values.  Morphing allows you to easily glide between these 
values.

Morph sensibility state is seen using alpha blend, and can be modified by using CTRL key 
while adjusting the knob.

You can easily toggle between both morph states by left-clicking the ASSIGN button, 
located in the top left of Discovery under the "Morph" label.  When the ASSIGN led is 
active, all parameter modifications are being made to the MORPH state.

Once both states have been defined, you can easily morph between them by assigning 
the Wheel MOD to MORPH mode.  Once set, moving your mode wheel will morph 
between both states.

RESET button below ASSIGN will set MORPH sensibility state zero. A confirmation dialog 
box will appear before applying the reset.

TIPS

● Reset knob morph state by using Ctrl+Alt+Left Click.

● MIDI velocity to Morph can be disabled by clicking the led below modulation wheel 
or using EDIT > Swap > MIDI Velocity to Morph.

● Knobs from four layers at once can be moved using Alt+Mouse, but if you don't 
want to apply maximum and minimum value limits use Shift+Alt+Mouse

● Four layer edit shortcuts can be applied to Morph values by enabling Morph 
Assign button.
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Global Layer Options

● Oct Shift: Used to shift the pitch in octaves of the layer.

● Pitch Bend - The pitch bender allows you to drastically change the pitch of the 
current patch in real-time. You can modify the pitch bend range from 1 to 24 
semitones by clicking the LCD arrows or clicking numbers for a drop-down menu.

● Modulation Wheel: Can be assigned to modulate the following parameters:

○ FLTR: Filter cutoff frequency.
○ FM: OSC2 to OSC1 frequency modulation amount.
○ OSC2: OSC2 pitch.
○ LFO1: LFO1 amount.
○ MORPH: Morph between source and destination morphing states.

● CHR: Left-click the CHR button to enable Chorus, Phaser or both modes at once.  

● Play Modes:

○ MONO: Only 1 voice of the synthesizer is used for the layer. In this mode any 
note played will discontinue the previous note.

○ LEGATO: A monophonic mode in which envelopes are not restarted when new 
keys are played.

○ POLY: Polyphonic mode allows multiple notes to be played at once.

● Portamento: Portamento glides the pitch between the current note and a newly 
played note.  The higher the value, the slower the transition progresses.

○ Auto: When enabled, glide/portamento will be only applied if overlapping notes 
are played (legato).
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Oscillator Section
Oscillators are the basis of sound generation in subtractive synthesis.  Discovery includes 
two primary oscillators, each with various modes and waveform types.

Waveforms available in Discovery are:

Wave Sounds

Sine FM, Leads, Percussion, Organs

Triangle FM, Smooth Sounds, Bass, Flutes

Square Smooth Basses, Leads, Synced Waves

Noise Ambient FX, Percussion

Saw Rough Bass, Edgy Leads

Pulse Vintage Synths, Pads
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Oscillator 1 (OSC1)
OSC1 is the primary sound source in Discovery.  This oscillator uses the pitch of the 
incoming note and plays it in the specified waveform type. OSC1 can be one any of the 
following waveform types (shown from the top down):

● Sine.
● Triangle.
● Saw tooth.
● PWM (Pulse Width Mod).
● Square.

You can quickly switch between any waveform by simply left-clicking the button below 
the waveform list.  A RED LED indicates the currently enabled waveform.

Frequency Modulation: Discovery features a true frequency modulation (FM) engine, 
allowing the OSC1 carrier wave to be modulated by frequency of the OSC2 output.

FM Amount: Sets the amount of FM used to modulate OSC1 frequency.
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Oscillator 2 (OSC2)
Discovery offers a second oscillator, which adds additional sound design capabilities to 
your patches.

The second oscillator may be used in various ways such as mixing with, or modulating 
the frequency of OSC1.  

OSC2 can be set to any of the following waveforms:

● Triangle.
● Saw.
● PWM (Pulse).
● Noise.
● Square.

Controls for oscillator 2 are:

● Semitones: This knob allows you to shift the pitch of OSC2 from -60 to +60 
semitones.  The following features apply:

○ When in use, a BLUE LED will activate at full scale values:

-60, -48, -36, -24, -12, 0, 12, 24, 36, 48, 60

○ When OSC SYNC mode is active OSC2 will reset each time OSC1 finishes a 
cycle. (Explained below).

○ When noise wave is selected, this control is used to determine the frequency 
range of the noise (from low frequency to high frequency noise).

If noise wave is selected and OSC SYNC mode is active, the semitones control is a 
digital noise wave selector, from a table of 8 different random sound shapes.

● Fine Tune: Fine-tuning of OSC2 from a range of -0.5 to +0.5 semitones.

● KBD Track switch: When on, the OSC2 will track pitch of incoming note.
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Oscillator Modes

● Pulse Width: Determines the de-phasing amount between the two saw tooth 
waves that build up the Pulse wave.  This results in the pulse width of BOTH 
oscillator pulse wave shapes (only works for PWM).

Lesser values (turned left) result in a square formed PWM.  Higher values result in a 
train of small pulses.

● OSC SYNC: OSC2 phase will reset each time OSC1 completes a cycle, giving 
harsh and fuzzy effects on the OSC2 sound.  In this mode the OSC2 semitone 
control will not determine the pitch shift, but rather the harmonic content of the 
wave that will modify the pitch of the OSC1.

● RING MOD: OSC1 output will multiply the OSC2 output. When this mode is turned 
on, the FM control in the OSC1 will work as pitch tune (in the range of 0 to +12 
semitones) for the OSC1.  This mode can be used for special effects and ambience 
sound shapes.

● OSC MIX: Used to mix both oscillators output.  Knob values follow:

○ Left: 100% OSC1 Signal
○ Middle: 50% OSC1 Signal, 50% OSC2 Signal
○ Right: 100% OSC2 Signal
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Filter Section

Once the oscillators are mixed, sound is next routed through the Discovery filter section.  
This section will transform the frequency response of the signal.

A filter is a unit that changes the magnitude of a range of frequencies of the sound, 
boosting or cutting these frequency values.  

Basic Filter controls

The two most common filter parameters are the Frequency and Resonance controls.

● Frequency: or 'cutoff' point.  This value sets the frequency point affected by the 
filter response.

● Resonance: This value determines the amount of amplification of the range of 
frequencies surrounding the frequency (cutoff) point.
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Filter Types

Discovery has 8 filter types. You may toggle through these types using the buttons below 
the LCD Filter Type section or by clicking filter name LED to make a drop down menu 
appear. The active filter is also showed in the display.

Available filter types follow:

● LowPass 12db: This 2 pole Lowpass filter will cut all spectrum range above 
the Cutoff frequency, with a rolloff of -12dB per octave.

● BndRjct 24: The Notch filter will cut the frequency range surrounding the Cutoff 
point, and will be processed thru the 24dB Lowpass filter explained above, but 
using a slightly shifted Cutoff frequency.  Using this with high Resonance amounts 
will result in interesting vocal formants effects.

● LowPass 24db: A 4 pole Lowpass Filter with -24dB per octave rolloff. This 
functions similar to the LP 12db, but with a steeper frequency curve response.

● BndPass 24: A Bandpass Filter, which allows only the frequency range 
surrounding cutoff point to pass through. Resonance controls the size of this 
bandwidth.

● HghPass 24: The opposite of the Lowpass filters, the Highpass will pass 
frequencies above the cutoff point and will cut all range below. This filter type has 
a rolloff of -24dB per octave.

● HghPass 12: Will pass frequencies above the cutoff point and will cut all range 
below. This filter type has a rolloff of -12dB per octave.

● Formant: 2 bandpass parallel filters tuned in vocal formant frequency range. 
Resonance modifies both filters resonance.

● 8 Tap Phaser: 8 tap allpass filters phaser. You can assign a LFO to this filter in 
order to get a nicer effect.
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Filter Envelope

Filter Envelope allows easy filter Cutoff ADSR (Attack, Decay, Sustain, Release) envelope 
based modulation.

● Attack: Controls for the time in which the filter envelope moves from 0 (note play) 
to full filter (based on the Envelope Amount, below).

● Decay: Controls the time length between the end of attack and the sustain level.

● Sustain: Sets the filter point at which envelope stays while note is continually 
pressed, once attack and decay have completed.

● Release: Begins once the note is released, controlling the time the gain will fall 
from current envelope point (Sustain) until complete.

● Env Amount: The Envelope Amount option controls the amount of the Filter 
envelope applied to the Cutoff frequency.  

● Vel: When enabled, the Envelope Amount will be scaled with the incoming note 
based on velocity.  This results in more dramatic envelopes for harder hit notes.

Additional Filter Options

● Kbd Track: When active, Keyboard Tracking will increase the filter cutoff 
frequency based on incoming note pitch.  Higher notes will add higher frequencies 
to the current filter cutoff point.

Tracking can be 1/2 (minor), 2/3, or Full (very drastic).

● DIST: Distortion effect with dual modes.  

○ Asymmetric Distortion: This will apply saturation to the negative field of the 
signal. This will generate side harmonics, useful for tube distortion effects.

○ Symmetric Distortion: Saturation will be applied symmetrically, resulting in 
odd harmonics, useful for grunge or distortion effects.

○ Asymmetric Distortion 2: A variation of first asymmetric distortion.
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Modulation Section

Low Frequency Oscillator 1 (LFO1)

Discovery includes two LFO's (Low Frequency Oscillators), and a Modulation Envelope 
(with 2 stages and state variable amount control). LFO oscillators operate much like the 
basic Discovery oscillators, only at much slower speeds

Rate: This control sets the speed (frequency) of LFO1.  Smaller values result in slower 
oscillations, larger values in faster oscillations.

LFO1 can use various waveforms (from top to bottom):

● Lowpass Random: Like random waveform, but the value is a smooth curve.

● Square: If LFO1 phase is above the half of the period length, the LFO will take the 
highest value, otherwise the lowest.

● Triangle: Also a ramp, but moves down to up, then back to down in a single cycle. 
Primarily used for sweep effects.

● Saw Tooth: Ramp shape; will move up to down, then instantaneously up when 
cycle is completed.

● Random: Each time LFO1 completes a cycle, it will select a new random value.

Retriggered LFOs: By cycling through LFO waveform options a second time you can 
enable Retriggered LFO's.  This means that the LFO will be restarted each time a note is 
played.  Retriggered LFO's are indicated by RED LEDs.

Destination: To the left to the waveform selector is the LFO1 Destination selector.  This 
feature allows you to choose which control(s) this LFO will modulate. The following LFO1 
modulation destinations are available:

● FM: OSC2   OSC1 FM (Frequency Modulation) amount.
● FILTER: Filter cutoff frequency.
● OSC2:  OSC2 pitch.
● OSC1+2: Both OSC1 and OSC2 pitch.
● PW: Width of the pulse of PWM waveforms.

Amt: LFO1 Amount control determines the amount of LFO output to use on the 
destination control(s).  Higher values will result in a more dramatic modulation.
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Low Frequency Oscillator 2 (LFO2) and Arpeggiator (ARP)

The second LFO operates much like the first, yet without a selectable waveform.  LFO2 is 
always a pure sine wave.  In addition LFO2 has a powerful Arpeggiator (Explained below).

Rate: Controls the speed (frequency) of LFO2.

Destination: The following destinations are available to LFO2:

● OSC1+2: Both OSC1 and OSC2 pitch
● AMP: Amplitude (Creates a Tremolo effect)
● FILTER: Filter cutoff frequency

Amt: LFO2 Amount control determines the amount of LFO output to use on the 
destination control(s).  Higher values will result in a more dramatic modulation.

LFO2 Arpeggiator

ARP: You can enable Discovery's Arpeggiator by left-clicking the ARP button in the LFO2 
section.  When active, LFO2 operates in ARP (Arpeggiator) mode.

An Arpeggiator is basically a simple sequencer which continually plays notes 
automatically as a note or notes are held.  The notes played depend of the keys currently 
pressed and the arpeggiator range.

Rate: When in ARP mode, the Rate control sets the arpeggiator tempo.  Faster values 
may be achieved with greater values (turning the knob to the right).

Destination: In Arp mode, direction in which the Arpeggiator will play notes. 
They can be:

● DWN: Plays notes from highest to lowest, then restarts.
● U&D: Repeats playing highest lowest, then back from lowest to highest.
● UP: Plays lowest to highest, restarts.
● RND: Plays any random note from the arpeggiator range.
● RND2: Play to the next or the prior note in the arpeggiator range randomly.

Arp Rng: Sets range in octaves for the arpeggiator, from 1 to 5 octaves.

17



Modulation Envelope

The modulation envelope is a simple envelope which includes 2 stages, attack and decay.

Attack:  Changes the value of the destination (based on the Amount) from the time a key 
is pressed until its highest point.

Decay:  Changes the value of a destination (based on the Amount) from the highest point 
until the sustain level is reached.

Destination:  The following destinations are available to the Mod Envelope:

● FM: Frequency Modulation Amount
● PW: Pulse Waveform Width
● OSC2: OSC2 Pitch

Amount: Sets modulation.  This modulation can be positive, negative, or anything in 
between.  Three basic settings include:

● Negative: All the way to the left, reduces the destination
● No Amount: Center, disabled.
● Positive: All the way to the right, increases the destination.
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Amplifier

Discovery's Amplifier applies an envelope to the output gain of the current layer of sound. 
This is the final stage of synthesis.  The following controls apply:

● Attack: Controls for the time that envelope moves from note press (0) to full 
volume. (Does not apply to legato mode).

● Decay: This knob controls the time length between envelope gain goes from upper 
point (end of Attack) to Sustain level.

● Sustain: Sets the point at which the envelope stays while note is held.  This state 
is held until the note is release.

● Release: Once the note is released, this knob will control the time in which the 
gain will fall from current envelope point (Sustain) into complete silence, finishing 
the voice use. 

Longer releases can result in many simultaneous voices, resulting in high CPU 
usage.

● Gain: Adjusts the overall volume for the current layer. Use morphing to add 
dynamics.

● Limiter: Applies a compressor with –Inf:1 ratio for the current layer.
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Panning, Delay/Echo and Gate

Discovery has built in stereo delay, panning and gate effect units.

Panning

This effect can be used to widen a sound or give it interesting panning effects per layer. 
You can sync Mod Rate to host tempo by clicking the led located next to Mod Rate knob.

● Position: Position in the stereo field.

● Mod Rate: Controls rate of the stereo modulation.

● Mod Amount: Controls depth of the stereo modulation.
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Delay/Echo

This effect can be used to add spacey echo effect, or widen a sound. You can sync 
Left/Right Delay to host tempo by clicking the led located between Left and Right knobs.

● Level: Controls the amount of the delay effect.  No Level value (knob turned 
completely to the left) will disable the delay effect. This control is morphable as 
well.

● Left / Right Delay: Controls delay time of the unit for each channel.

● Left / Right Feedback: Controls time of delay tail.  Moving this knob to the right 
will increase the tail.

● Cross switch: Adds a cross-feed to the feedback output, resulting in a stereo 
bouncing delay. Useful for 3d effects.
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Gate

If you want to enable Gate page effect, you can do so by clicking the small  led next to 
GATE.

NOTE: Enable and disable multiple gate steps by left clicking and dragging the mouse 
while moving on the pattern.

● Level: Controls amount of the gate floor effect.  No Level value (knob turned 
completely to the right) will disable the effect.

This control is morphable and layer independent, suitable for complex sound 
textures.

● Copy: Copies current gate pattern to memory.

● Paste: Dumps gate pattern on memory to current gate.

● Gate pattern: Controls gate triggering.
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Midi CC table

CC# Controller

001 Wheel Mod

007 Amp Gain

005 Portamento

008 Oscillator Mix

015 Playmode

017 Oct Shift

018 Wheel Mod Mode

019 LFO1 Rate

020 LFO1 Waveform

021 LFO1 Destination

022 LFO1 Amount

023 LFO2 Rate

024 LFO2 Arp/Dest switch

025 LFO2 Amount

026 MOD ENV Attack

027 MOD ENV Decay

028 MOD ENV Destination

029 MOD ENV Amount

030 OSC1 Waveform

031 OSC2 Waveform

033 OSC2 Fine Tune

034 OSC2 Kbd Track 

035 OSC2 Sync/Ring/Both

036 Amplifier Decay

037 Amplifier Sustain

CC# Controller

089 Filter Attack

039 Filter Decay

040 Filter Sustain

041 Filter Release

042 Filter Resonance

043 Filter Env

044 Filter Type

045 Filter Velocity

046 Filter Kbd Track

065 Portamento Auto

070 OSC FM

072 Amplifier Release

073 Amplifier Attack

074 Filter Cutoff

078 OSC 2 Semitones

079 Pulse Width

080 Filter Distortion

081 Delay Level

082 Left Delay

083 Right Delay

084 Left Delay Feedback

085 Right Delay Feedback

086 Panning Position

087 Panning Mod Rate

088 Panning Modulation

120 All Sounds Off

123 All Notes Off
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Importing SysEx

Discovery can import SysEx patch dumps from using software able to record MIDI SysEx 
data dumps.

On Discovery GUI, press MENU button  > File > Import Nord Lead 2 SysEx

A popup menu appears, then press Import NL2 patch dump, and select your .syx or .ngf 
file (Both are MIDI unformatted Sysex data dump).

NOTES:

● Full bank patch dumps will be done into current selected layer.
● Nord Lead 2 sounds may sound slightly different.
● Performance and Percussion Kits dumps are not supported.
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Unison Edit

Unison is a straightforward editing command that can be customized. It takes values from 
the first layer (A) and applies them to all layers (A, B, C, and/or D) depending on the 
preset.

If we open Unison.txt located in Documents > discoDSP > Discovery in a text editor, 
we can see a list of default presets and how to create new ones. Let’s take a look at the 
first one: Double.

Double   1 1 0 0  0.5 0.5 0 0  0.2 0.8 0 0  0 0 0 0  0.3 0.7 0 0

● First four values mean that only Layers A and B will be affected 1 1 0 0 where A 
(1) B (1) C (0) D (0). 

● Second values are gain. 0.5 in a 1 to 0 range means Layers A and B will have 50% 
gain each. 

● Third values are panning. Layer A will be panned about 25% Left and Layer B 
25% right. 

● Fourth values are osc2 octave pitch shift. Since values are 0 they will all remain 
in the same octave.

● Fifth values are the osc2 fine-tune. As we can see Layer A and B will be detuned 
about 25% up and down respectively.

Adding and removing presets is as simple as removing or copy/paste a line and saving.

Edited Unison presets will take effect next time Discovery is instanced.
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Version History

Release 6.1

● Polyphony is now fixed at 32 voices.
● Updated the oversampler DSP with dynamic processing, setting 2x as the default 

for 44-48 kHz project frequencies and automatically switching to 1x for frequencies 
above 48 kHz.

● Optimized synth voice DSP.
● Fixed legato mono play modes for correct behavior.
● Refactored DSP process block for more stable processing.
● Implemented new GUI image caching for faster drawing performance.
● Fixed pitch bend GUI issue and doubled the mouse drag range for more precise 

sound design.
● Added new preset functions: Save and Paste > Program and Save, which now 

save to the active bank.
● Refactored internal functions to prevent memory leaks and buffer underruns.
● Modernized popup menus with updated pointers to avoid memory leaks.
● Improved DSP initialization.
● Fixed a UTF8 issue with the bank path.
● Fixed the right delay LCD status issue.

Release 6.0

● Enhanced oscillator resolution with a 2x increase, significantly improving sound 
quality, especially in the low and high ends, without aliasing.

● Upgraded framework for improved compatibility and stability.
● Introduced a new standalone app.
● Improved license activation process.
● New popup menu with a custom font based on the OS, featuring a sleeker black 

translucent look and a more modern design.
● Increased default voice limit values to 16.
● HQ distortion is now always on, and the setting has been removed.
● Added tick-to-grid value conversion on the LCD display.
● Streamlined config files. Unison presets now use a .txt extension for easier editing.
● Fixed several GUI repaint issues.

Release 5.5

● Issues with VST3 parameter automation have been resolved.

Release 5.4

● Linux build has been optimized.
● Issues with VST3 parameter binding have been resolved.
● Built-in online license activation implemented.
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Release 5.3

● Resolved an issue with the VST2 build that caused the plugin state to reset after 
saving a project.

Release 5.2

● Framework update.
● Fixed the incorrect binding of the Delay Mix knob to Pitch Bend on the VST3 build.
● Fixed the reset behavior Layer function.
● Fixed the reset of the bank on BitWig Studio with the VST3 build.

Release 5.1

● Added multi-size GUI 1x, 1.5x and 2x including Retina HiDPI displays.
● Updated framework. 
● Fixed VST3 delay mix and pitch bend issue.
● Fixed bank and preset recall.

Release 5.0

● New Silver Haze GUI. 
● Updated framework. 
● Fixed Logic Pro Audio Unit plug-in error after opening an existing project.
● Revised PDF manual.

Thanks to David Smith valuable help on this release.

Release 4.5

● Updated framework fixing VST3 parameter issues and greater stability.
● Fixed AAX init patch bug.
● Linux VST3 build.
● Removed Linux curl dependency for greater compatibility.
● macOS Universal 2 Binary compiled with XCode 12.4 and new build system.

Release 4.4

● ProTools AAX plugin format support for Windows and macOS.
● macOS Universal 2 Binary builds for Apple Silicon chips.
● macOS system minimal requirement is now 10.9.

Release 4.3

● Upgraded framework for increased stability and compatibility.
● Active voices are now muted on program change.
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● 64-bit only now.
● Compiled with latest Xcode, VS 2019 and Ubuntu 18.

Release 4.2

● VST3 support for Windows and Mac.
● Upgraded framework for increased stability and compatibility.
● Fixed BandReject filter acting as LowPass.
● Updated Demo Buy URLs.
● Full Linux support.
● Manual revision.

Release 4.1

● Up to 2X CPU speed optimizations.
● Smaller file size.
● Simpler dialog boxes descriptions.
● Streamlined Morph knob display.
● Export/Import point to better folder locations.
● Added Buy links to EDIT menu on Demo version.
● Reworked and streamlined EDIT menu.
● FX Bypass moved to main EDIT menu position.
● Mac GUI shows R4.
● Fixed Cubase hangs.
● Fixed Import/Export file paths.

Release 4.0

● New zero-feedback delay filters modeled after the Nord Lead 2.
● High contrast drop down menus.
● Discovery data location placed at ~/Documents/discoDSP/Discovery/
● Manual revision.

Release 3.3

● 64 bit Audio Units support for Mac.
● 64 bit VST support for Windows.
● New selected item EDIT menu background color.
● Instant refresh in Bank Browser for new FXB files.
● Better preset renaming dialog box.
● Manual revision.

Release 3.2

● Sound engine fixes.

Release 3.1
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● Edit > Config > Midi Out switches Discovery's VST MIDI Out.
● MIDI CC 30 and 31 now use full range instead one number for each oscillator.
● OS X cross-preset compatibility between PowerPC and Intel projects.

Export as FXP/FXB first before updating and import into R3.1.
● Overall bug fixes.
● Manual revision.

Release 3

● Better automation support (Apple Logic).
● Edit > Program > Rename Preset.
● Edit > Import > Import FXP.
● Faster SSE3 assembly optimized versions.
● Windows version fully ported from v2.10 to R3.
● Native Linux support.
● Minor enhancements.

Release 2

● Audio Units Universal Binary.
● FXB/FXB export.
● Unison Edit.

Drop /Library/Audio/Discovery_Data/unison.cfg to a text editor for more 
information.

● Discovery Mono works as expected.
● VST and Audio Units can be installed at /Library/Audio/Plug-Ins too.
● Discovery_Data will be looked at /Library/Audio/Plug-Ins/ to allow AU and VST 

share the same file.
● Renamed plugins in order to avoid Logic or GarageBand confuse Demo and 

Registered versions. Trashing files from ~/Library/Cache/ used to fix this problem.

Release 1

● Initial Release.

Copyright

discoDSP Discovery is © discoDSP. All rights reserved.
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